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Each year the Office of the Secretary of Defense (OSD) publishes a table
of inflation rates, outlay rates and preliminary military and civilian pay
raise assumptions. These rates are used to prepare the President's
Budget and to support congressional justification materials.
Unfortunately, many ACEIT users are realizing that their program's actual
inflation is different from the rates handed down from OSD. As aresult,
users need to create indices that more accurately reflect their program's
true inflation.

This presentation will cover all the steps necessary to prepare custom
Indices:

®m Where do the indices in ACE come from?

m Why and how would I create them?

m \What tools do | use to create these new indices?
m How do | use them once they're created?
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Base Year (BY)
e A reference or starting year - the value of a dollar is 1

Escalation (Inflation) Rate
e The percent change in money’s value from one year to another

Outlay Rate

e Percentages per year telling how funds are expended for a particular
appropriation

Raw (Compound) Indices

e Indices calculated by compounding the inflation rate each year
Weighted (Composite) Indices

e Indices calculated using raw indices and outlay rates
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"

_ Where do the Indices Come
R YEANN From?
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OFFICE OF THE UNDER SECRETARY OF DEFENSE

1100 DEFENSE PENTAGON
WASHINGTOMN, DC 20301-1100

10 201

COMPTROLLER

MEMORANDUM FOR SECRETARIES OF THE MILITARY DEPARTMENTS
CHAIRMAN OF THE JOINT CHIEFS OF STAFF
UNDER SECRETARIES OF DEFENSE
DEPUTY CHIEF MANAGEMENT OFFICER
COMMANDERS OF THE COMBATANT COMMANDS
DIRECTOR. COST ASSESSMENT AND PROGRAM

EVALUATION

DIRECTOR, OPERATIONAL TEST AND EVALUATION
GENERAL COUNSEL OF THE DEPARTMENT OF DEFENSE
INSPECTOR GENERAL OF THE DEPARTMENT OF DEFENSE
ASSISTANT SECRETARIES OF DEFENSE
ASSISTANTS TO THE SECRETARY OF DEFENSE
DIRECTOR, ADMINISTRATION AND MANAGEMENT
DIRECTOR. NET ASSESSMENT
DIRECTORS OF THE DEFENSE AGENCIES
DIRECTORS OF THE DOD FIELD ACTIVITIES

SUBJECT: Inflation Guidance - Fiscal Year (FY) 2013 President's Budget

The attached inflation rates, outlay rates, and preliminary military and civilian pay raise
assumptions supersede those used in preparation of the FY 2012 President's Budget. These rates
are to be reflected in the FY 2013 President’s Budget submission, as well as supporting
congressional justification materials.

ACEIT Example Files, 18 September 2012 Approved for Public Release



rates

m And outlay profiles

Outlay Rates To Be Used For Incremental Changes in BA Purchases
(As Percent of BA Purchases; Excludes Pay and Fuel Dollars)

Procurement -Air Forece
Air Force Awrcraft

Air Force Missiles

Air Force Annnunition
Air Force Other

Procurement - Defense Wide

Procurement, Def Wide
NG Equipment
Defense Prod Act
Chemical Demil

m Guidance shows inflation

FIRST SECOND THIRD FOURTH FIFTH SIXTH SEVENTH

YEAR YEAR YEAR YEAR YEAR YEAR YEAR
7.00 40.00 27.00 14.00 8.00 250 150

30.00 31.00 23.00 300 400 200 200
4.50 45.00 3050 9.20 5.00 3.00 2380

60.00 25.00 5.00 3.00 200 1.00 1.00

24.00 38.00 24.00 7.00 350 200 150
3.00 20.00 40.00 27.00 10.00

59.00 25.00 16.00

53.00 30.00 15.00 200
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Fiscal
Year

2011
2012
2013
2014
2015
2016
2017

2011
2012
2013
2014
2015
2016
2017

2011
2012
2013
2014
2015
2016
2017

Inflation Guidance - FY 2013 President's Budget

RDT&E

Ec’

14
16
17

PRICE ESCALATION INDICES

(Annual Rates in Percentages)

) 0&M
Mil Con"  (Excl Fuel

FH Const and DHP)
OUTLAYS
20 20
19 19
17 1.7
16 1.6
138 18
18 18
18 18

18 1.9
1.7 138
17 1.7
18 1.7
18 18
18 18
18 18

PAY RAISE ASSUMPTIONS *

Military
14

16
1.7

Fuel

-0.3

242
153

-129
-03
03
0.6

Mil Pers ¥

Non-Pay
(Excl Med
Accrualy

CPI-U
Medical



B Services use this guidance to create inflation tables

APN = Aircraft Procurement, Navy (1506)

NAVY Base Year= 2012 18-Jul-12 _
OPR: SAF / FMCEE
Budget | Date of OSD Inflation Rates: 10-Feb-12
_ _ . Budget| Year | pgip of SAFIFMCEE Issue: £-Mar-12
Fiscal |Inflation| Raw |Weighted| Year | Inflation | .. ccpompcpoicon 7-Mar-12

Year | Rate % | Index Index Index Rate %
1970 3.93%| 0.1843] 0.1948] 0.1890 : .
1971] 4.55%| 0.1926]  0.2030] 01970  4.24% USAF Raw Inflation Indices
1972] 3.83%| 0.2000] 02127] 02064] 4.78% Based on OSD Raw Inflation Rates
1973] 4.16%| 0.2083] 02347] 0.2276] 10.30% Base Year (FY) 2009
1974 5.77%| 0.2204] 0.2458] 0.2386] 4.80%
1975 8.81%| 02398] 02594] 02617] 550%

1976) 6.59%| 0.2556 0.2768| 0.2685 5.69% General ~ Operations  Research,

197T| 3.56%| 0.2647 02928 02841 579% Military Compensation Senices & Maint. ~ Develop., Aircraft &

1977| 3.78%| 0.2747 0.3068| 0.2977 4.80% Pay Other & Wage MNon-Pay, Testing, Military Missile Other

1978 E-BU:’{” 0.2334 0.3366| 03265 9-58:’5 Fiscal Base Expenses Total Retirement Board Pay  Mon-POL  Evaluation Construct. Procurement Procurement Fuel
1:;3 13;5;;: gg;gg gi;gg gig?g Hgg;: Year (3500) (3500) (3500) (3500) (3400) (3400) (3600) (3300)  (3010/20)  (3080)

19811 11 60%| 0 3980 046760 045361 11 33% 1949 0.053 0.097 0.058 0.100 0.050 0.124 0.127 0.124 0.116 0.126 0.068
1982] 14 30%| 0.4549 050801 04928 B 63% 1950 0.060 0.101 0.064 0.096 0.053 0.122 0.125 0.122 0.114 0.124 0.067
1083 9 00%| 04958 05404] 05242 £.38% 1551 0.083 0.109 0.065 0.155 0.052 0.130 0.133 0.130 0.122 0.132 0.073
1984 B8.00%| 05355 0.5621| (0.5453 A.02% 1952 0.063 0.109 0.068 0.152 0.056 0.134 0.137 0.134 0.126 0.136 0.070
1985| 3.40%| 05537 05784 05611 2.90% 1953 0.067 0.110 0.071 0.154 0.057 0.137 0.139 0.137 0.128 0.139 0.071
1986] 2.80%| 05692 05960] 05782 3.05% 1954 0.067 0.108 0.071 0.144 0.060 0.138 0.141 0.138 0.129 0.140 0.070
1987 2.70%| 05845 0.6169| 05985 3.61% 1955 0.068 0.111 0.073 0.152 0.064 0.140 0.143 0.140 0.131 0.142 0.074
1988 3.00%| 0.6021 0.6437| 0.6245 4.35% 1956 0.072 0.115 0.077 0.163 0.069 0.144 0.147 0.144 0.135 0.146 0.078
1989 4.20%| 0.6274] 0.6695| 0.6495| 4.00% 1957 0.071 0.120 0.076 0.169 0.072 0.149 0.152 0.149 0.140 0.152 0.083
1930 4-“”:’5 0.6525 0.6926| 0.6719 3-45:’:’5 1958 0.075 0.132 0.081 0.171 0.081 0.153 0.156 0.153 0.143 0.155 0.084
1991) 4.30%) 06805 07125 06912 287% 1959 0.080 0.134 0.085 0.183 0.086 0.156 0.159 0.156 0.146 0.158 0.086

1992| 2.80%| 0.6996 0.7285| 0.7067 2.25%
1993] 2.70%| 0.7185 0.7421] 0.7199 1.86%
1994 2.00%| 0.7328 0.7558| 0.7332 1.85%
1995] 1.90%| 0.7467 0.7680| 0.7450 1.61%
1986] 2.00%| 0.7617 0.7788| 0.7555 1.40%
1997 1.80%| 0.7754 0.7855| 0.7620 0.86%
1998| 0.70%| 0.7808 0.7946| 0.7708 1.16%
1999| 0.80%| 0.7871 0.8048| 0.7807 1.28%
2000{ 1.40%| 0.7981 0.8155] 0.7911 1.33%
2001 1.80%| 0.8124 0.8252| 0.8005 1.19%
2002| 0.80%| 0.8189 0.8356| 0.8106 1.26%
2003] 1.00%| 0.8271 0.8523| 0.8268 2.00%
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m ACEIT contains system-provided databases containing OSD inflation indices
for several Government agencies

e Air Force
Army

Def Agency
FAA
MARAD
NASA
NAVSEA
Navy
USCG
USMC

| Automated Cost Estimating
Integrated Tools

Support Center
Support Alerts
Support Calls
Release Notes
Downloads
Library
Knowledge Base

ACEIT Instructional
Videos

FAQs

Automating‘the Estimating.EfVironment

Products Services Training Support About Us My ACEIT

Home > Support Center = Inflation Indices 2012

Inflation Indices 2012

The installation file below will update your ACEIT system inflation database to include
the latest version of the 2012 inflation indices.

In general, inflation rates have decreased slightly; the outlay rates/profiles have
changed for several appropriations. Users will see a slight decrease in their budget
estimates. Download and installation instructions.

The inflation indices are provided for use with ACEIT 7.0 and higher as of 13 March
2012.

Available Indices by Agency and Date (As of 13 March 2012):

Agency 2012%|2011|2010|2009|2008|2007|2006|2005(|2004|2003|2002
Air Force X X X X X X X X X X X
Army X X X X X X X X X X X
Def x x |x x| x x| x ] x [ x| x
Agency

FAA X X
MARAD X X X X X X X X X X X
NASA X X X X X X X X X
NAVSEA X X X X X X X X X X X
NAVY X X X X X X X X X X X
NRO X X

S0CoM X X

usmc X X X X X X X X X X X
UscG X X X X X X X X

DoFA/Australia XF* X X X X X

* See below for details on all the indices that have been updated so far. Remember
that the 2012 table contains the entire set of indices, but some of the rates are from
the last available update.

m Theseindices are updated each year as they are released by OSD
e ACEIT users with up-to-date DMS can download these updates from ACEIT.com

e These updates are self-installing programs which update the ACEIT system database to

contain the latest system inflation indices

ACEIT Example Files, 18 September 2012
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W]hy an@] How do | create my
N\ own indices?
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B There are many reasons you may need to create custom indices
e The program is experiencing inflation at a different rate
than what is reported by OSD
e You want future costs to reflect greater inflation than predicted

e Others?

B You need three pieces of information in order to manually
calculate inflation indices
1. Base year to create indices for, e.g., 2012

2. Escalation rate(s)
1. You can have a single escalation rate, e.g., 3% per year
2. You can have escalation rates that change each year, e.g., 2010 = 2%,
2011 = 2.2%, 2012 = 2.5%, etc.
3. Outlay Profiles (optional)
1. For appropriations where all the money appropriated in one year gets spent
in that year, outlay rates don't exist, e.g., Military Pay

2. Number of years of outlay rates depend on life cycle phase
m Typically Procurement contains the greatest number of outlay years; O&M contains the fewest

3. Outlay rates add up to 100%
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B The equation to calculate the index (l,,) from base
year b to year n is
o I, =(1+Ep )" (1+Ep.)* ... *(A+E)*(1+E,)
» where E,, is the escalation rate for year n.
m Example: Create index to inflate costs to 2015 from
base year 2012
® lyo15= (1+E5013)* (1+E014)*(1+E015)
e Assume E,y;5= 1.7%, E,p;,=1.6%, and E,;,5=1.8%
® S0 lyos = (1+.017) * (1+.016) * (1+.018) = 1.0519

e This means that you need to add 5.19% inflation to go from 2012
to 2015
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It takes time for the DoD to spend a given amount of
money

m Funds, though obligated in one year, will be
expended (or spent) over several subsequent years

m QOutlay rates represent the percent of total obligation
authority (TOA) expended in any particular year

Fiscal Year Tri Tr2 Tri Trd Tro Tre6 Trd Total
2010 3277% | 48.89% | 12.22% | 3.42% 1.83% 0.87% 100.00%
2011 2613% | 55.50% | 12.91% | 3.61% 1.94% 0.91% 100.00%
2012 24 31% | 56.11% | 13.05% | 3.65% 1.96% 0.92% 100.00%
2013 14.565% | BB.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2014 14.65% | BB.63% | 22.35% | 3.68% 1.97% 0.92% 100.00%
20145 14.56% | 56.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2016 14.56% | 5B.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2007 14 56% | BB.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2018 14 56% | 56.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2019 14 56% | 56.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2020 14 66% | 56.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2021 14.565% | BB.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2022 14.65% | BB.63% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2023 14.56% | 56.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2024 14.56% | 5B.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
2025 14 56% | BB.53% | 22.35% | 3.68% 1.97% 0.92% 100.00%
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W@r@ht@@ﬂ ﬂm@ﬂr@@s

When applying an expenditure profile some money is spent in
out years

m Out years have inflation which decreases the purchasing power
m Deflating using the yearly raw indices gives adjusted (BY) value

Total Funds Awarded
Qutlay Rates
Time Phased Costs

Raw Inflation Index
Constant FY 2012 Equivalent

m Our real purchasing power is only $490.14

m If we want $500 of purchasing power throughout our spending
period, we must begin with more money
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Ve eed
Wf@fghﬁ@@ﬁ Indices

B \We need to account for the additional inflation that
occurs as the money is spent

m Do this by inflating the time phased costs using the
yearly raw indices

Desired Purchasing Power
Qutlay Rates

Time Phased Costs
Raw Inflation Index
Inflated Costs

m In order to get $500 of purchasing power over our

spending period we need $510.17 awarded in the first
year
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m There are two different formulas used to calculate
the weighted inflation index

e The general formula to calculate weighted index (WI), for year n, is
defined as

> W, = /(O )n/1)HO oynea/ lne 1) - (O oyl Ins(p-1)
e The Army and selected other services use the following equation
> W= (O 1n)+(Oyns1 )+ (O™ s o)

Oyn Is the decimal outlay percentage for out year p, in year n.

l,, IS the raw index for year n

B The general formulais more accurate because the
outlay profile is computed from and applies to then
year dollars rather than constant year dollars
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Fiscal
Year

2011
2012
2013
2014
2015
2016
2017

Procurement - Navy
Navy Aircraft

ACEIT Example Files, 18 September 2012

m How do you get from here

Inflation Guidance - FY 2013 President's Budget

PRICE ESCATATION INDICES
(Annual Rates in Percentages)

Mil Pers ~
O&M Non-Pay
Mil Con" (Excl Fuel (Excl Med
Proc EDT&E TH Const and DHP) Fuel Accrual)
OUTLAYS
20 20 20 20 2472 20
19 19 19 19 153 19
1.7 1.7 1.7 1.7 31 1.7
1.6 16 16 1.6 -12.9 16
18 18 18 18 03 18
1.8 1.8 1.8 1.8 03 18
18 18 18 18 0.6 18
13.00 35.00 26.50 14.00 7.00 3.00

Approved for Public Release

1.50

m to here?

APN = Aircraft Procurement, Navy (1506)

NAVY Base Year= 2012 1-Aug-12

Budget

Budget | Year

Fiscal |Inflation| Raw [Weighted| Year | Inflation

Year | Rate % | Index Index Index | Rate %
2011 2.00%| 0.9814 1.0133[ 09830 1.81%
2012 1.90%(| 1.0000 1.0308[ 1.0000 1.73%
2013 1.70%[ 1.0170 1.0485( 1.0172 1.72%
2014| 1.60%| 1.0333 1.0671 1.0352 1.77%
2015] 1.80%| 1.0518 1.0863[ 1.0538 1.80%
2016] 1.80%| 1.0708 1.1058( 1.0728 1.80%
2017 1.80% [ 1.0901 11257 1.0921 1.80%
2018] 1.80%| 1.1087 1.1460( 1.1118 1.80%
2019] 1.80%[ 1.1287 1.1666[ 1.1318 1.80%
20200 1.80%| 1.1500 1.1876[ 1.1521 1.80%
2021 1.80%[ 14707 1.2090( 11729 1.80%
2022]  1.80%| 11918 1.2308[ 11940 1.80%
2023 1.80%| 1.2132 1.2628) 1.2155 1.80%
2024 1.80%[ 1.2351 1275856 1.2374 1.80%
16




e Base Year = 2012

Escalation Rates

2011
2012
2013
2014
2015
2016
2017

2.0%
1.9%
1.7%
1.6%
1.8%
1.8%
1.8%

ACEIT Example Files, 18 September 2012

B Use escalation rates to calculate raw indices

Ro011 = Roo12/(1+E5015)
=1/1.019

Calculated Inflation Indices
Raw
2011 0.981354

—

2012 1
2013 1.017

|

2014 1.033272
2015 1.051871
2016 1.070805 ___

| 2017 1.090079
2018 1.1097
2019 1.129675
2020 1.150009

R2013 = Ro012*(1+E5013)
=1*1.017

Rooxx = Rooxx-1*(1+E5017)

2021 1.170705 = | For xx = 17 through 24

2022 1.1917382
2023 1.213234
2024 1.235072 J

Approved for Public Release

R,0;, = 1.0708 * 1.018
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weighted indices

2011
2012
2013
2014
2015
2016
2017
2018
2019
2020
2021
2022
2023
2024

ACEIT Example Files, 18 September 2012

Raw Outlay Rates
0.981354 First Second  Third Fourth
1 Year Year Year Year
13.0% 35.0% 26.5% 14.0%
1.017 ‘
1.033272
1.051871 Weighted
1.070805 — 2011 1.013318
1.05900739 2012 1.020798
1.1097 2013 1.048482
1.129675 2014 1.067073
1.1500059 2015 1.086281
1.170709 2016 1.105834
1.191782 2017 1.125739
1.213234 2018 1.14e002
1.235072

m Use raw indices and outlay rates to calculate

Fifth Sixth Seventh
Year Year Year
7.0% 3.0% 1.5%

W12 = 1/(Oy1/Rp012

+O0y,/R 013 +Oy3/Ro014
+0y4/R5015 *Oys/Ro016
+Oy6/R2017 +Oy7/R015)

W,0p, = 1/(.13/1 + .35/1.017
+.265/1.0333 + .14/1.0519
+.07/1.0708 + .03/1.0901
+.015/1.1097)

Note: The Navy uses the general formula to calculate weighted indices. If

you use the Army calculation, the resulting index for 2012 is 1.03133

Approved for Public Release
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W]h@n"@ do | create my own
SN\ indices?
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ACEIT:LIBRARIAN

m Librarian lets you build your own Inflation Indices and CER Libraries

m These user-created indices can be stored in a custom database and are
portable; they can be accessed from multiple ACE sessions and can easily
be shared with other ACE users

ACEIT Example Files, 18 September 2012 Approved for Public Release
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1. Open the Librarian
e Start > Programs > ACEIT > ACEIT Tools > ACEIT Librarian

-

5| g8

File Edit Library Documentation Tools ‘iew Help
DHGR B A0SR  BovFF .=+ ¢ =<
Inflation Libra@ | Table: [SampIeTabIe V] E H ﬁ
Code Term Description Revision
DoFA 1234 Samp Fxed 5% increase 20-Jul-2001
H-ig USG

Methodology Library

I

ACEIT Example Files, 18 September 2012
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Tasks .

New Appropriation

New Inflation Table

New Sppropriation Wizard

Edit Appropriation Properties
Edit Indices

Delete Appropriation

Edit Selected Inflation Table
Delete Selected Inflation Table

Favontes .

Recent Libraries [}
Custom

UsG

DoFA

Aust

Sample CER Library

SUSTOM

Appropriation

21



2. Create New Inflation Table

e Edit > New Inflation Table or New Table icon (2)
e Enter table name, as of date and year type

-
4 Custom - ACEIT Librarian Editor

File | Edit | Library Documentation Tools View Help
5| @7 New Appropriation L BESE = ij_j-ﬁ\

' Edit Appropristion Properties

B ’Sample Table

7

Ei  Edit Indices

A CUSTOM

A

Appropriation

¥ = <= | 5| 44

!

k’_ Delete Appropriation
Pt S

Tem

Samp

Description
Fixed 5% increase

[ Edit Inflation Table

Rewvision
20-Jul-2001

Tasks .

Mew Appropriation

New Inflation Table

Cut Appropriation [n Year Type

O |

@ Fiscal

Methodology Library

(@ Calendar

Delete Inflation Table Name: ((My Custom Table|
Copy Appropriation cfl| As Of Dat€_ 14-fug-2012 i~

F Start Month: [gmba

B New Infision Table ) [ — Pmmrﬁmﬂu Feproprizon izsre

Appropnation Properties
Indices
ete Appropriation

I Selected Inflation Table
ete Selected [nflation Table

orites .

tent Libraries [ 2]

0K

| | Camesl | | Hebp

] ktom

ACEIT Example Files, 18 September 2012

Approved for Public Release

snple CER Library
UsG
DoFA

Aust
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3. Create Custom Appropriation

e Edit > New Appropriation or select New Appropriation from

Tasks window

~

+ Custom - ACEIT Librarian Editc
i Edit | Library Documentpn Tools View Help
© Ny New Appropriation lBoya @il ¢ =< |56
a Edit iation Properti
= it Appropriation Properties L [MyCustorn Table v] = = Eg Tasks
~N [ EditIndices N —
= o Tem Description Revision (| Mew Appropriation
- %/ Delete Appropristion Mew Tnflation Table
ﬁ I Mew Inflation Table MNew Appropriation ‘Wizard
[ Edit Inflation Table Edit Appropristion Properties
Edit Indi
G Delete Inflation Table inless o
Delete Appropriation
5 Copy Appropristion  Cirl+C Edit Selected Inflation Table
&  Cut Appropriation Ctrl+X Delete Selected Inflation Table
@ r - Favontes
Recent Libranes
Custom
UsG
DoFA
Methodology Library Aust
Sample CER Library

1

ACEIT Example Files, 18 September 2012
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J e CUSTtom
Appropriation

3. Create Custom Appropriation
e Enter information about appropriation

i
Appropriation Details
p
+ o o[ S
A

Code: 1506 Revision Date:  13-8ug-2012  [E-

Term: APM Base Year 2012 =

-

Phase Code: |Prod - [ ]

Description:  |Custom calculation for Mavy Aincraft

i Inflation | n Wwizard
ation Inputs B N Properties
) Fixed Rate: @ Raw/'Compound indices (") early Escalation Rates
From Year: 2011 |2 ToYear 2024 |2 on
ktion Table
Use \Weighted flation Table
7) MNone @ ‘Weighted'Composite Indices (7) Dutlay Rates/Expenditure Profiles o
Calculation Method: .
Inflation Source
I Agency: | KEVad - Source
Corde
ary
Source
Mhmm et b e

OK || Cancel |[ Help
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Inflation Inputs

i7) Fixed Rate:

Ilze weighted

i) None

B Fixed Rate
e Simplest to define

e Enter fixed
escalation rate

e Typically do not
have weighted
indices

ACEIT Example Files, 18 September 2012

(7 Weighted/Composite Indices @ Outlay Rates/Expenditure Profiles

Calculation Method: /1 M|
Ay
Standard

m Raw/Compound

Indices
e Enter yearly

inflation indices

e Specify which years
you have calculated

indices

e Typically entered

with weighted

Indices but may not
have weighted

Approved for Public Release

B Yearly Escalation
Rates

e Enter yearly
escalation rate

e Specify which years
you have escalation
rates

e Typically also
specify outlay rates
along with
calculation method

e May not have
weighted

25



4. Enter indices

e Depending on Inflation Inputs options, different inputs are
required

File Edit Help

- e
ol Appropriation Indices - APN, 1506 - Custom calculation for Navy Aircraft (BY2012)
B ————

Year Escalation (%) Compound Composite
1 2002 | 2.500: .78119840172572: .73119840172572
2 2003 2.500: .80072836176887: .80072836176387
3 2004 2.500: .82074657081309: .82074657081309
4 2005 2.500: .84126523508341: .84126523508341
5 2006 2.500: .B6229686596050: .86229686596050
[ 2007 2.500: .B8385428760951: .B8385428760951
) 2008 2.500: .90595064479975: .90595064479975
8 2009 2.500: .92859941091974: .92859941091974
9 2010 2.500: .95181439619274; .95181439619274
10 2011 2.500: .97560975609756: .97560975609756
11 2012 2.500: 1.0000000000000: 1.0000000000000
12 2013 2.500: 1.0250000000000: 1.0250000000000
13 2014 2.500: 1.0506250000000: 1.0506250000000
14 2015 2.500: 1.0768906250000: 1.0768906250000
15 2016 2.500: 1.1038128906250: 1.1038128906250
16 2017 2.500: 1.1314082128906: 1.1314082128906
17 2018 2.500: 1.1596934182128: 1.1596934182128
18 2019 2.500: 1.1886857536682: 1.1886857536682
19 2020 2.500: 1.2184028975099: 1.2184028975099
20 2021 2.500: 1.2488629699476: 1.2488629699476
21 2022 2.500: 1.2800845441963: 1.2800845441963
22 2023 2.500: 1.3120866578012: 1.3120866578012
23 2024 2500 1.3448888242463: 1.3448888242463
24 2025 2.500: 1.3785110448524: 1.3785110448524
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CUSstOm

Appropriation

@ Fixed Rate:

25 %

m Fixed Rate

e No additional inputs
are required

e The Librarian uses
the fixed rate to
calculate inflation
indices
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4. Enter indices
Depending on Inflation Inputs options, different inputs are

required

-

u-l Appropriation Indices - APN, 1506 - Custom calculation for Navy Aircraft (BY2012)
e —

File Edit Help

.ﬁ' ||.J|£||TJ“ jﬁjﬁé‘ Bz & Lﬁ

Year Escalation (%) Compound Composite
1 2011 .981354269000008 1.0133179410000
2 2012 1.900: 1.0000000000000; 1.0307932070000
3 2013 1.700: 1.0170000000000: 1.0484822420000
4 2014 1.600: 1.0332720000000: 1.0670733990000
5 2015 1.800: 1.0518708960000: 1.0862807200000
G 2016 1.800: 1.0708045720000; 1.1058337730000
Fi 2017 1.800: 1.0900790540000: 1.1257387810000
8 2018 1.800: 1.,1097004770000: 1.1460020790000
9 2019 1.800: 1,1296750860000: 1.1666301170000

2020

1.800

1.1500092380000

1.1876294550000

2021

1.800

1.1707094040000

1.2090067830000

2022

1.800

1.1917821730000

1.2307689110000

2023

1.800

1.2132342520000

1.2529227520000

2024

1.800

1.2350724650000

1.2754753610000
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d CUSTOM

Appropriation

@ Raw/Compound indices

From Year 2011 = | ToYear: 2024 =

m Raw/Compound
Indices

e Copy/paste from
other source or type
directly into white
cells

e The Librarian
calculates the
escalation rate
based on the
indices
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JraClustom

A@E@@Eﬁ@ﬁﬁ@m

4. Enter indices

e Depending on Inflation Inputs options, different inputs are

I‘eq Ul I’ed i@ Yearly Escalation Rates
s Appropriation ndices Custom calculation for Navy Arcraft @V2012) | = e
- Appropriation Indices - APM, 1506 - Custom calculation for Navy Aircraft (BY2012) L= From Year: 2011 =] To Year: 12024 =

File Edit Help m =

o 3033 % 4 @ m Yearly Escalation Rates

Escalation Yearl Year2 Year3 Year4 Year5 Year® Year7

Year (%) Compound Composite on) (o6) (%) (%) (%) (%) (%) _

1 2011 2.000] 981354268; 1.01331794 13.000; 35.000} 26.500; 14.000; 7.000i 3.000i 150 e Enter escalation and

2 2012 1.900 1.00000000; 1.03079820 . .

3 2013 1700, 1.01700000 1.04848224 outlay rates into white cells
It 2014 1600 1.03327200; 1.06707339

5 2015 1800 1.05187089; 1.08628072 i i

6 2015 1800 1.07080457 1.10583377 e The Librarian calculates the
7 2017 1,800} 1.09007905: 1.12573878 raw and Welghted indiceS

8 2018 1800 110970047 1.14600207

9 2019 L6800 112967508 116674101
|10 2020 1.800 115000923 1.18808446 e Ifno OUtIayS are entered for
11 2021 L800 117070940 121037284 ;

12 2022 1.800 119178217 123423104 a partICUIar year, the

13 2023 L6800 121323425! 126083267 i i

14 2024 1.800 123507246 1.29115403 Librarian uses the last

entered rates

Note: Add additional outlay years

from the Edit menu
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reaiting a2 Custom

F@@Eﬁ@ﬁﬁ@[ﬁm

AP
4. Add additional appropriations as needed

e New appropriations will be added to the custom table

5. EXxit the Librarian and Save changes

;
4+ Custom - ACEIT Librarian Edj W=y

File | Edit Library Documentation Toolz View Help
New I BRIFEO LR EOIFH T2+ 82| F A

b Save P Library Table: | My Custom Table ] BEH R rasks o
=% -

=3 Import Code Temn Description Revision ‘ New Appropriation

.ETE_ Export

Ent priation \Wizard

riation Properties

ropriation
Inflation Table
ed Inflation Table

Favontes .

Recent Libraries B
Custom
Sample CER Library
DoFA
UsG
] 7 Aust
4 1

Methodology Library
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\How do | use my custom
RN indices?
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m From ACE, open Session Properties dialog
e Select File > Properties from the ACE main menu

RI£K and Corfig Reparting I Format I Summary
General I Calculation I Emors | Inflation

System Inflation Table

Name: [US Govemment Indices for FY 2012 v]

As of Date: 08Mar2012
Year Type: Fiscal Start Month: OCT

Custom Inflation Table

Code/Term

| [ cancel | |[SetasDefaut| | Hepp

ACEIT Example Files, 18 September 2012 Approved for Public Release

Edit  View Documenta

Mew... Ctrl+M
Open... Ctrl+0
Close Session  Ctrl+F4
Save Ctrl+5
Save As...

Protect...

Send To »
Print... Ctrl+P

Insert Section...

Save Section...

iy | gt (@

| “r' Properties...
Approprigtion Type Rece
@ Codes (=.q., 36500) (©) Terms (e.g., RDTEF) Exit Alt+F4
Seszion Rates
Code  Description Rev Date Table
3600 Rsch, Dev, Test & Eval  25Feb2012  System .
WO ook P 22072 Sygen m  From the Inflation tab, select the
Clear Cached Rates | | Transferto Custom DB... | desired custom inflation table

e Note: Custom indices take
precedence over System for
appropriations with same



.3 - [01 - Basic -

I ¥ File Edit View Documentation Calc

1 E Cases Reports Tools Window Help -5 X
0= - e REEN A A 3|83 56| = 72| 100% | Arial ~8 ~A-O5-|B LU $u5‘_'
Methodology -EEEL-B-va-nPHoy RERIYVE=TFTEIAIQ BA@ER¥UY
11 - " 1506
¥ 07 - Detailed LCC...clogy (BY20125K) " % 01 - Basic ACE -...ology (BY20125K)
. . Point Phasing .
[
WBS/CES Description Approp| Unique ID Estimate | Method Equation / Throughput
= EXAMPLE FILE =
1
i *Estimate *Estimate
3 Total $113,256.736*
4 Manufacturing PMPS| 582284522*
5 Ar Vehicle 3010 AVS 571552106+ F AV_UCS * BuyQty
B Integration 30 $10,732.816* F 0.15* AVE
T SEPM 3o £30445421* F 0.37 * PMPS
I g Other 3080 $526.393* ™ [Cost Throughput]
|| el
10  *INPUT VARIABLES *IN_VAR
1 Air Vehicle First Unit Cost 1506 - I ANV_UCS §10221.725* C (959 * W 243 + 189 * RANGE * 852)/ 2 200
12 AirVehicle Buy Quantity -
13 3010 - AR FORCE - Aircraft Procurement T
14  *TechnicallPerformance Characteristics 3080 IH FORCE Other F'roc For I an H
15  Air'Vehicle Takeoff Weight (Ibs) 3JB00 - AIR FORCE - Rach, Dev, Test & Eval
: : ; 3020 - AlR FORCE - Mizzile Procurement
16 AirVehicle Range (nmi) 3400 - AR FORCE - DM - NonPay, Mor-Pol
17 00 - AR FORCE - Military Construction
18 302 - AIR FORCE - Q& - Fuel
19 3730 - AR FORCE - MILCOM - 4F Reserve
I 3830 - AlR FORCE - MILCAOM - air Matl Guard
II 20 3740 - AIR FORCE - OBM - AF Reserve
21 3840 - AlR FORCE - Oh - Air Matl Guard
22 3[00 - AlIR FORCE - Military Perzonnel - Total
T 3801 - AIR FORCE - Military Personnel - Pay Base Al
il = 302 - AIR FORCE - Military Personnel - Other Expenses 2 ’
I
WES/CES 3, Methodelegy 4 Vearly Phasing /
Ready MNUM

LS

ACEIT Example Files, 18 September 2012
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B You can easily create custom indices for use
iIn ACE

m System indices in ACE are based on OSD
guidance

B You may need to create custom indices if your
program experiences inflation different from
what is projected by OSD

m Use the ACEIT Librarian to create indices

B Select the new table from the Inflation tab of
the ACE Session Properties dialog
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m Contact Information
e Gina Fennell
e (fennell@tecolote.com

e (805) 679-8605

m General ACEIT Support
e Aceit support@tecolote.com
e (805) 964-6963
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